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Information regarding product documentation.  
A regularly updated and expanded list of publications, with indication of languages available, can be consulted at the 
following address: 
http://www.sequoia.it/it/setacMT.htm 
For other Sequoia IT documents, products and technical support, go to the address 
http://www.sequoia.it/it/prodotti.htm 
 
Technical Support  
National phone numbers for technical support can be found on the following website: 
http://www.sequoia.it/it/contatti.htm 
 
Use 
Maintenance planners, maintenance engineers and specialist technicians. 
 
Intended audience  
This User Guide is intended to assist users in installing SeTAC for Machine Tools and in selecting machine tool condition 
monitoring parameters. 
 
Contents of the User Guide  
The User Guide comprises five chapters and addresses all the problems involved in using the SeTAC for Machine Tools 
system. The first chapter introduces the method of use. The second chapter illustrates SeTAC for Machine Tools 
technical characteristics and describes installation of the hardware. The third and fourth chapters illustrate installation of 
the software and use of Machine Airbag. The last chapter contains application notes. 
 
Standard configuration  
The capabilities described in this documentation may not correspond to those of the system furnished which may feature 
other functions in addition to those described in this documentation. This does not, however, imply any obligation to 
implement such functions in the case of new supplies or technical assistance. For capabilities added or replaced by 
Sequoia IT, consult the documentation or contact the technical support service at the address info@sequoia.it  
For reasons of clarity, this documentation does not contain all the detailed information regarding various versions of the 
product and cannot consider and cover all possible cases of SeTAC for Machine Tools assembly, functioning and 
personalisation. 
 
Definition of qualified person  
For the purpose of this manual and of the warnings indicated on the product or by the software, a qualified person is a 
person familiar with the installation, assembly, commissioning and functioning of the product with the following 
professional qualifications: 

• is trained and authorised to energize/de-energize circuits and equipment in accordance with current safety 
practices 

• is trained in current safety practices for the proper care and use of protective and safety equipment 
• has attended update and training courses held by Sequoia It or by organizations/schools authorised thereby. 
• is trained in rendering first aid. 
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CERTIFICATION OF CONFORMITY 
In accordance with IOS/IEC Guide 22 and EN45014, the manufacturer, Sequoia IT, declares that SeTAC for Machine 
Tools complies with EMC 89/336/EEC – CE Marking 93/68/EEC Directives and with the following harmonised standards: 
Emissions: EN 61000-6-4 (2001); 
Immunity: EN 61000-6-2 (2001). 
 

 

The crossed out wheeled bin symbol indicates that, in accordance with Directive 2002/96/EC on the 
recycling of waste electrical and electronic equipment (WEEE) inside the European Union, the product 
is subject to separate collection at the end of its life. In addition to this device, such regulation applies to 
all accessories marked with this symbol. These products must not be disposed of as unsorted municipal 
waste but collected and recycled separately. 

 
 
Copyright  
All the contents (text, graphics and images) of this manual are protected by copyright. 
Partial use of this document is permitted provided that: 
 

• the copyright notice indicated below and the present authorisation terms appear on all copies 
 
• such documents are used only for information, personal and non-commercial purposes and such use does not 

imply copying and/or disclosure on computer networks and other media 
 

• the documents used are not modified. 
 
Any other use is expressly forbidden by law.  
Any product or company mentioned in this manual are trademarks of their respective proprietors or owners and may be 
protected by patents and/or copyrights granted or registered by the competent authorities. 
 
Warranty  
In accordance with Legislative Decree No. 24 of February 2, 2002, this warranty is valid for 24 months in case of sale to 
private individuals. In the case of sale to companies, professionals or persons taxable for VAT, the warranty is valid for 12 
months. 
For further information and assistance, visit our product section at www.sequoia.it or send an e-mail to info@sequoia.it 
 
 
 
 
 
 
 
 
 
 
 
Disclaimer 
This manual has been drawn up by Sequoia IT. Read this disclaimer and the legal notes carefully as use of SeTAC for 
Machine Tools implies automatic acceptance by the user of the terms set forth therein. Sequoia IT reserves the right to 
make any changes to the disclaimer and legal notes published on this page at any time. Sequoia IT makes all 
reasonable efforts to ensure that any information provided in this manual is free of errors, inaccuracies and omissions. 
However, all information contained herein is provided “as is”. Sequoia IT makes no warranty regarding the reliability and 
accuracy of the results obtained with its software and shall not be liable for any direct, indirect, incidental and 
consequential damage caused by proper or improper use, for loss of profits, interruption of business or professional 
activity, loss of data or other types of data located in the user’s IT system or other systems. This disclaimer is not 
intended to evade compliance with the obligations of applicable legislation or evade liability in cases where this cannot 
be excluded under such legislation. All and any disputes arising between the user and Sequoia IT in relation to use of 
SeTAC and related software or for any other reasons will be submitted to the exclusive jurisdiction of the Court of Turin. 
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Introduction 

  
  

 

 

Thank you for choosing SeTAC for Machine Tools. 

 

SeTAC for Machine Tools is produced by SEQUOIA IT, a leading company with 

long-term experience in the development of expert vibration monitoring 
solutions.  

SeTAC for Machine Tools is the Sequoia IT machine tool monitoring and control 
system that: 

• detects vibration overload; 

• calculates effective hours of spindle operation; 

• improves production process performance;  

• protects the machine against collisions in the work area. 

SeTAC for Machine Tools also operates as machine tool “black box” able to log 

up to 12,000 vibration events with indication of time and amplitude of the 
phenomena. 

During the warranty period, this capability provides machine tool manufacturers 
with feedback regarding correct operation by the machine tool user, avoiding or 
reducing claims due to improper use to a minimum. 

In the case of collisions, SeTAC for Machine Tools can stop the machine in just 
1 ms, thus reducing possible impact damage (options: SeTAC TK Advanced 
Interface - SeTAC TK Full Interface). 

SeTAC for Machine Tools advanced functions promote optimisation of 

maintenance times and costs with a consequent improvement in machine tool 
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efficiency and productivity. 

SeTAC for Machine Tools also allows machine tool and event log remote control 
via Ethernet (on Modbus TCP) (options: SeTAC TK Communication Interface - 
SeTAC TK Full Interface) making it possible to increase productivity in complete 

safety. 

SeTAC for Machine Tools also permits interfacing via field bus (PROFIBUS or 
others available on request) for integration of vibration monitoring and analysis 
capabilities and control logics directly on the CNC. 
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Hardware Installation 

 

 

 

  

 

SeTAC for Machine Tools (Fig. 1) comprises the SeTAC TK triaxial vibration 
sensor, the SeTAC TK Interface and Machine Airbag software. 

This User Guide provides information regarding the installation, configuration 
and use of SeTAC for Machine Tools necessary for efficient, productive use by 
expert personnel in possible application scenarios.  

The various types of configurations, method of installation and problems 
inherent in SeTAC for Machine Tools vibration monitoring are illustrated to help 

you understand the flexibility of the system and to use it with maximum 
productivity. 

 Fig. 1: SeTAC for Machine Tools system 
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Sensor characteristics  

The SeTAC TK triaxial vibration sensor is a smart device able to process 

acceleration measurements, thus permitting autonomous, univocal tracking of 
phenomena such as collisions, vibration overloads and also calculation of 
spindle service life consumed. 

The SeTAC TK sensor is extremely sturdy (IP67), shock resistant and compact 

(30 x 55 x 15 mm) and comprises a high-performance processor (Fig. 2) 
programmed with specific algorithms for detection of the phenomena to be 
analysed that can be programmed via the SeTAC TK Interface. 

The SeTAC TK can log and save up to 12,000 vibration events with indication of 

the time of occurrence and amplitude of the phenomena, also discriminating 
these according to type. The events saved in the internal memory of the device 
can be easily acquired via software (Machine Airbag) on a USB link or in remote 

mode via Ethernet (optional). 

The SeTAC TK sensor features state-of-the-art technologies such as latest 

generation MEMS triaxial accelerometers able also to measure major 
acceleration phenomena (full scale ±18 g) in a frequency range of between 0 
and 2500 Hz  

 

As specified in the paragraph on positioning, the SeTAC TK (SEQUOIA Triaxial 

Acceleration Computer) sensor must be installed directly on the machine close 
to the nose of the spindle. 

 

Fig. 2: Sensor characteristics  
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Assembly of the sensor  

Positioning and fastening 

The SeTAC TK sensor must be fitted as close as possible to the nose of the 
spindle or rigidly fastened to the body of the spindle in order to permit precise 
monitoring of vibrations (Fig. 2). Usually, the closer the sensor is mounted to the 
source, the more satisfactory the monitoring results obtained. To obtain reliable 
measurements, for the purpose of signal analysis, the SeTAC TK sensor must 
be installed on a flat surface.  

The best method for securing the SeTAC TK sensor is to insert four lag screws 
in the holes in the box. These must be firmly secured in order to detect shocks 
characterised by high frequency signals and to avoid adding other vibrations 
(which would modify the vibrational signal to be processed). 

 

 

Care of cables 

Pay maximum attention during assembly to avoid damaging the sensor, cable 
or indirect damage to the machine tool. For extension cables, Sequoia IT 
recommends use of good quality cables, also indicating availability on request 

 

Fig. 4: SeTAC for Machine Tools M12 Cable. 

Fig. 3: Sensor positioning 
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of the SeTAC M12 Cable (Fig. 4) [Part Number SC-M12-0CL] (for information 
info@sequoia.it). 

When fitting a cable, take care not to cut and/or damage the insulation or crush 
the internal wiring. 

 

 

 

SeTAC TK Interface  

The SeTAC TK Interface operates as sensor programmer and interface for 

communication with a computer, PLC and/or with the machine tool CNC (Fig. 
6). 

According to your specific configuration (Fig. 5), the SeTAC TK Interface 
features various interfaces for external communication, including USB, Modbus 
TCP and/or Modbus RTU.  

Prior to installation, always check your reference configuration. 

Fig. 5: Configurations and capabilities. 
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Field bus and Modbus  

Modbus is currently one of the most widely used industrial electronic device 
communication protocols worldwide. 

SeTAC for Machine Tools uses Modbus to connect a supervisory computer with 
a SeTAC TK Full Interface or SeTAC TK Communication Interface for remote 

control, acquisition of measurements and synchronisation of the technological 
process with the level of vibration detected. 

  

 

SeTAC TK Full Interface and SeTAC TK Communication Interface implement the 
version of the Ethernet protocol (modbus TCP) but the RTU version is also 

 

Fig. 7: Field Bus available adapters 

Fig. 6: SeTAC TK Advanced Interface 
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available as option.  

Other field buses, such as PROFIBUS, are also available using specific 
converters (Fig. 7). 

The various configurations of the SeTAC Interface are shown below. For 
problems tied to interfacing of SeTAC for Machine Tools via Modbus, consult 

the specific documentation. 

Selecting the interface 

Selecting the most suitable interface for requirements is one of the most difficult 
decisions for the user. The four interfaces available are illustrated briefly in Fig. 
8 below to facilitate selection of that most suitable. 

 

 

 

 

 

 

Fig. 8: Selecting the interface - features available 
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SeTAC TK Basic Interface  

[Part Number: SSI-TK-001-0-0-000] 

SeTAC for Machine Tools equipped 
with the SeTAC TK Basic Interface (Fig. 
9) provides all the instruments 
necessary for local machine tool 
monitoring and control, creating a black 
box inside the machine that permits: 

• logging and time-based 
cataloguing of collisions; 

• logging and time-based cataloguing of vibration overloads; 

• calculation of spindle effective working hours divided according to vibration 
level ranges. 

SeTAC TK Basic Interface is equipped with DIN rails for secure fastening. 

Input/Output Connectors  

The SeTAC TK Basic Interface features a type B USB port, an M12 8-pin 

connector and a 3-pin terminal block connector (Fig. 10). The functions of the 
various pins of the terminal block connector are described in the table below. 

Pin 
Number 

Symbol Description  

 

 

1  IN 

This pin is the input for managing the 
option for activation of monitoring of 
the time to be used for calculation of 
effective hours of spindle operation; 

2 V+ Supply voltage (18 to 30V); 

3  GND Ground. 

     

The M12 8-pin round connector connects the SeTAC TK sensor with the SeTAC 
TK Basic Interface. 

Fig. 10: terminal block 
connector 

Fig. 9: SeTAC TK Basic Interface 
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SeTAC TK Advanced Interface 

[Part Number: SSI - TK - 001 - 1 - 0 – 000]  

The SeTAC for Machine Tools system equipped 
with the SeTAC TK Advanced Interface (Fig. 11) 

provides all the instruments necessary for local 
machine tool monitoring and control and fast 
emergency stopping, permitting in particular: 

• logging and time-based cataloguing of 
collisions; 

• logging and time-based cataloguing of 
vibration overloads; 

• calculation of spindle effective working 
hours divided according to vibration level 
ranges; 

• use of 3 output relays (2 normal and 1 fast) to stop the machine tool 
and/or to activate external devices; 

• saving, viewing and back-up of events in the event log (black box 
function). 

The SeTAC TK Advanced Interface is equipped with DIN rails for secure 
fastening. 

Fig. 11: SeTAC 
TK Advanced Interface 



Hardware Installation  
SeTAC for Machine Tools Architecture 

 SeTAC for Machine Tools  -  User Guide Page 11  

 

Fig. 12: Terminal block connector pin-out 
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Input/Output Connectors 

The SeTAC TK Advanced Interface features a USB port (mini type B), an M12 

8-pin connector and a 14-pin terminal block connector (Fig. 12). 

The functions of the 14 pins of the terminal block connector are illustrated in the 
table below. 

Pin 
Number 

Symbol Description 

1 GND Ground; 

2 V+ Supply voltage; 

3 COM3 Central contact relay 3; 

4 OUT3A NC contact relay 3; 

5 OUT3B NO contact relay 3; 

6 COM2 Central contact relay 2; 

7 OUT2A NC contact relay 2; 

8 OUT2B NO contact relay 2; 

9 COM1 Central contact relay 1; 

10 OUT1A NC contact relay 1; 

11 OUT1B NO contact relay 1; 

12 GND Ground; 

13 IN2 Reserved for future applications 

14 IN1 This pin is the input for managing the option for activation of 
monitoring of the time to be used for calculation of effective hours of 
spindle operation. 

The M12 8-pin round connector connects the SeTAC sensor with the SeTAC TK 
Advanced Interface. 
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SeTAC TK Communication Interface  

[Part Number: SSI - TK - 001 – 0-1-TCP]  

The SeTAC for Machine Tools system 
equipped with the SeTAC TK Communication 
Interface (Fig. 13) provides all the instruments 

necessary for local and remote machine tool 
monitoring and control, permitting: 

• logging and time-based cataloguing of 

collisions; 

• logging and time-based cataloguing of 

vibration overloads; 

• calculation of spindle effective working hours divided according to vibration 

level ranges;  

• saving, viewing and back-up of events in the event log (black box 

function); 

• synchronisation of machining parameters and level of vibration. 

The Ethernet network permits: 
 

• remote access to the events log (black box function); 

• remote configuration of the device; 

• transmission by the SeTAC TK Interface of digital alarm messages; 

• synchronisation of measurements through buffering of the signals 

measured and integration of vibration data in the field bus of the machine. 

The SeTAC TK Communication Interface is equipped with DIN rails for secure 
fastening and various connectors. 

 

Fig. 13: 
SeTAC TK Advanced Interface. 
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Pin 
Number 

Symbol Description 

 

1 GND ground; 

2 V+ supply voltage; 

3 GND ground; 

4 IN2 Reserved for future applications; 

5 IN1 This pin is the input for managing the 
option for activation of monitoring of 
the time to be used for calculation of 
effective hours of spindle operation. 

Input/Output Connectors 

The SeTAC TK Communication Interface features a USB port (mini B type), an 

Ethernet TCP connector (via Modbus TCP) for remote control and a 5-pin 
terminal block connector. 

The functions of the 5 pins of the terminal block connector are illustrated in the 
table below (Fig. 14). 

The M12 8-pin round connector connects the SeTAC TK sensor with the SeTAC 
TK Communication Interface. 

 

 

Fig. 14: Terminal 
block connector pin-
out 
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SeTAC TK Full Interface  

[Part Number: SSI-TK-001-1-1-TCP] 

 

The SeTAC for Machine Tools system 
equipped with the SeTAC TK Full Interface 
(Fig. 15) provides all the instruments for 
machine tool monitoring, emergency 
stopping and remote control, permitting: 

• logging and time-based cataloguing 
of collisions; 

• logging and time-based cataloguing 
of vibration overloads; 

• calculation of spindle effective working hours divided according to 
vibration level ranges;  

• use of 3 output relays (2 normal and 1 fast) to stop the machine tool 
and/or activate external devices; 

• saving, viewing and back-up of events in the event log (black box 
function); 

• synchronisation of machining parameters and level of vibrations. 

The Ethernet network permits: 

• remote access to the events log (black box function); 

• remote configuration of the device; 

• transmission by the SeTAC TK Interface of digital alarm messages; 

• synchronisation of measurements through buffering of the signals 
measured and integration of vibration data in the field bus of the 
machine. 

 

Fig. 15: SeTAC TK Full Interface. 
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.  

Input/Output Connectors 

The SeTAC TK Full Interface features a USB port (mini type B), an Ethernet 

TCP connector for remote control and a 14-pin terminal block connector. 

The interface is equipped with DIN rails for fastening. The interface has a 14-pin 
terminal block connector (Fig. 16) with the following functions: 

Pin 
Number 

Symbol Description 

1 GND Ground; 

2 V+ Supply voltage; 

3 COM3 Central contact relay 3; 

4 OUT3A NC contact relay 3; 

5 OUT3B NO contact relay 3; 

6 COM2 Central contact relay 2; 

7 OUT2A NC contact relay 2; 

8 OUT2B NO contact relay 2; 

9 COM1 Central contact relay 1; 

10 OUT1A NC contact relay 1; 

11 OUT1B NO contact relay 1; 

12 GND Ground; 

13 IN2 Reserved for future applications; 

14 IN1 This pin is the input for managing the option for activation of monitoring 
of the time to be used for calculation of effective hours of spindle 
operation. 

 

Fig. 16: Terminal block connector pin-out 
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The SeTAC TK sensor is connected with SeTAC TK Full Interface by an M12 8-

pin round connector with the following functions: 
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SeTAC TK Full Interface – RTU 

[SI-1-1-RTU] 

 

Characteristics similar to the SeTAC TK Full Interface with the Modbus RTU 

communication protocol option. 

 

SeTAC TK Communication Interface – RTU   

[SI-1-1-RTU] 

 

Characteristics similar to the SeTAC TK Communication Interface with the 
Modbus RTU communication protocol option. 
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Software Installation 

 

 

 
  

To configure and use SeTAC for Machine Tools, the Machine Airbag software 

must be installed on a computer running under Microsoft Windows. Before 
installing the software, Sequoia IT recommends closing of all programs running 
on the computer and checking of system wiring, as explained in the previous 
chapter. 

 

To install Machine Airbag software, carry out the following operations in the 

order indicated: 

Step 1. Check wiring; 

Step 2. Insert the USB connector between the SeTAC TK Interface and the 

computer; 

Step 3. Wait until the operating system has completed installation of the 

driver; 

Fig. 17: Machine Airbag installation 
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Step 4. Insert the USB pen drive furnished with SeTAC for Machine Tools in 

the USB port; 

Step 5. Locate the “My computer” icon on the desktop and double click this; 

alternatively, click the Start key and then “Computer”; 

Step 6. Identify the SeTAC disc amongst the mass storage devices and 

double click the related icon; 

Step 7. Double click the Machine Airbag icon (Fig. 17) to start the 

installation software;  

Step 8. Follow the instructions shown on the screen and install the software. 

The importance of paying maximum attention to wiring is stressed as, if 
incorrect, it will not be possible to program the SeTAC TK correctly and use the 
system. 

Initial start-up and Configuration 

At initial start-up of Machine Airbag, the computer must be configured, setting 
the serial communication parameters between the computer and the SeTAC TK 
Interface. The computer and SeTAC TK Interface communicate on a USB serial 
port. 

The USB serial port will be created by the driver (FTDI) when the USB 
connector is inserted and must be dedicated exclusively to communication with 
SeTAC for Machine Tools. 

To identify the USB serial port created and used by the computer to 
communicate with the SeTAC TK Interface device, proceed as follows in the 

order indicated: 

 

Start button ► Control panel ► Hardware and Sound ► Device manager. 

 

As an alternative to the above method, enter the text devmgmt.msc in the run 

window of Windows. 

After launching Windows Device Manager (Fig. 18), if everything has been 
carried out correctly, a port denominated Usb Serial Port (Fig. 18) should 
appear in the list of peripherals amongst the LTP & COM ports.  



Software Installation  

Machine Airbag Setup 

 SeTAC for Machine Tools  -  User Guide Page 21 

 

It is good practice to make a note of the label assigned by the operating system 
to the USB Serial Port (usually, COM1-COM 3). 

The label of the port must not be higher than COM16; if the label assigned by 
the operating system (COM number) exceeds this value, reset the label to a 
value of less than 16. 

To modify the label of the serial port, access the properties of the USB Serial 
Port just installed. 

To do this, right click USB serial Port and select the Properties item from the 
text menu. 

In the Properties window, select Port settings, set the Bits per second field to 
115200 and click the Advanced tab. 

In the next window, the label of the USB Serial Port can be set, modifying the 
COM port number field indicated by the arrow (Fig. 18).  

At this point, start the Machine Airbag software, identify the menu bar and 

proceed as follows in the order indicated: 

 

Fig. 18: Windows device manager, identification of the USB Serial Port  
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Tools ► Options  

The Options will be displayed; in the combo box shown in the figure (Fig. 19) 
select the label of the virtual serial port, leaving 115200 as bit rate. 

 

 

 

Fast configuration of Machine Airbag 

For fast configuration of the system (it is necessary to switch to Administrator 
mode), the parameters to be set and related values are indicated in the table 
below. 

Sequoia IT strongly recommends that users carefully read the application notes 
in the last chapter of this manual for a complete overview of programming, 
control and management of SeTAC for Machine Tools devices.  

It is also advisable to take advantage of the assistance service proposed by 
Sequoia IT to customers for correct configuration of the system. 

To verify   set   to the  value  

Collisions  

High pass filter 35 HZ 

Low pass filter 65 Hz 

Limit3 
MODULE  
adopt a threshold value of 30 m/s2. 

   

 

Fig. 19: Setting of serial communication options. 
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Vibration overload  

Limit2 
RMS  
Adopt a threshold value twice that of 
limit 1. 

Limit1 

MODULE  
Adopt a threshold value twice the 
value recorded in the normal work 
cycle 

   

Calculation  of spindle  effective 
service life  Reduction factor Contact the Sequoia IT service 
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Machine Airbag 

 

 

 
  

 

Machine Airbag is the software developed by Sequoia IT for management, 
control and programming of SeTAC for Machine Tools system functions. 

Machine Airbag permits complete management of the SeTAC system for 

detection of collisions, recording of vibration overload, calculation of spindle 
service life consumption and control of black box mode. 

Administrator mode 

Administrator mode permits configuration and programming of SeTAC for 
Machine Tools. To enable Administrator mode, click the menu bar in the 

following sequence: 

File ► Administrator Log On 

The default password for SeTAC for Machine Tools is “SEQUOIA”. As the 

software is case sensitive, pay particular attention when entering the password. 

The parameters that can be modified by the Administrator are indicated in the 
table below together with the reference page of this manual. 

Parameter  Reference to page : 

Reduction factors 26 

Limit 3, Limit 2 and Limit 1 27 - 28 

Remove gravity 28 

Filters: high pass – low pass 28 

Monoaxial Low Pass 28 

Variation or synchronisation of the clock of the device. 29 

Enabling of the output with setting of the alarm. 29 

Management of the option for activation of monitoring 
of the time to be used for calculation of equivalent 
hours. 

26 

The Administrator must modify the password once the  device has been 
installed on a machine tool and preserve this in a safe place.  
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SuperUser mode  

In SuperUser mode, the expert user can modify only certain parameters such as 
Limit1 and Limit2 and related thresholds. Access to this mode is protected by a 
password that should be preserved with care. 

It is stressed that only Limit 1 and Limit 2 and related thresholds can be 
configured also in SuperUser mode. All the other parameters can be configured 
exclusively in Administrator mode. 

 

Software interface 

The Machine Airbag interface is similar to many programs for Microsoft 
Windows (Fig. 20) and comprises a menu bar, the setting area, a Graphics area 
and a status bar. The various components of the Machine Airbag interface are 

illustrated below. 

Menu 

The Machine Airbag menu bar comprises three pop-up menus from which the 

Fig. 20: Main window of Machine Airbag. 
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user can carry out various actions. The various items of the menu and related 
general description are shown in the table below. 

 

 

 Command Description 

File   

 

Administrator Log On Switches to Administrator mode 

Administrator Log Off Exits from Administrator mode 

Change Administrator password Modifies the Administrator’s password 

SuperUser Log On Switches to SuperUser mode 

SuperUser Log Off Exits SuperUser mode 

Change SuperUser Password Modifies the SuperUser password 

Exit Exits the program 

Tools   

 

Record events Access to the event log 

Archive/Restore Saves all SeTAC TK settings in a text file 

Options Access to Setup parameters  

Network configuration Configuration of the network 

System setting Settings of time and date – output configuration  

Upload firmware Update of the firmware 

help   

 About... Legal information  

   

Setting area  

The settings area shows the SeTAC for Machine Tools operating parameters 

that can be modified by the Administrator and partly by the SuperUser.  

The Statistics button can be used to verify settings for calculation of spindle 
service life consumed. 

The Alarms button can be used to verify level thresholds and filter settings. 
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Remember that, to modify the settings, it is necessary to change to 
Administrator mode; the SuperUser can modify Limit1 and Limit2. 

 

 

Statistics: setting of statistics  

Clicking Statistics (highlighted in red in Fig. 21), the table for calculation of 
effective hours of spindle operation is displayed. Refer to the application notes 
for the significance of the physical parameters indicated in the table.  

The value of the vibration velocity module recorded and measured in mm/s is 
shown to the right (Fig. 21). 

The combobox highlighted in green in Fig. 21 is used to manage the option for 
activation of monitoring of the time to be used to calculate effective hours of 
spindle operation. Remember that the INPUT signal must be furnished by 
connecting the appropriate IN1 pin of the SeTAC TK Interface to an output of 
the PLC that provides information regarding effective spindle rotation. 

All statistics section settings can be modified only in Administrator mode to 
prevent tampering or incorrect setting of reduction factors. 

The Export button (Fig. 21) can be used to save the reduction factors for 
calculation of service life consumed in a text file for backup or other operations. 

 

Fig. 21: Setting of statistics 
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Alarms: alarm setting  

Clicking the Alarms button (highlighted in red in Fig. 22) activates the section 
for setting the filters and Limits with related alarm limit thresholds. These 
settings are used to detect collisions and vibration overload. 

The Limits box (Fig. 22) shows three Limits for setting of level thresholds on the 
dynamic signals to be controlled. 

Through the level thresholds, it is possible to establish alert values at the 
acceleration module, at components of the acceleration vector or at RMS 
velocity values. 

To set a level threshold on a kinematic quantity (acceleration, velocity - RMS or 
other) proceed in the order indicated below: 

• change to Administrator mode 

• identify the Limit to be used; 

• in one of the three comboboxes, select the value to be controlled; 

• in the corresponding textbox, set the threshold value by writing the value 
(also using the ↑,↓, Pag ↑ or Pag ↓ keys). 

The colour of the textbox (Fig. 23) furnishes indications regarding overstepping 
of the threshold; in particular if the background is: 

• White: the level threshold (Limit) is not active; 

• Green: the level threshold is active but has not been exceeded recently; 

• Red: the level threshold has been exceeded. 

Fig. 22: Setting of alarms and level thresholds. 
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Each time a limit is exceeded, the software generates an event and SeTAC for 
Machine Tools records this in its internal memory (event log). 

As they can be configured also in SuperUser mode, it is advisable to dedicate 
Limit 1 and Limit 2 to detection of vibration overload. Limit 3 can be configured 
only in Administrator mode and should be dedicated to detecting collisions. 

Filters  

The Filters box (Fig. 22) contains the trackbar (bars) for setting the low pass, 
high pass, Monoaxial Low Pass filters and a checkbox to be ticked to subtract 
gravity from the acceleration measurement. 

Gravity is subtracted only from the monoaxial channels (absent by default on 
module and RMS) concurrently on all three channels. 

Low pass and high pass filters are applied only to acceleration. 

The Monoaxial Low Pass filter is applied concurrently to all acceleration 
components. 

System setting 

From the system setting menu item, the Administrator can modify the internal 
clock of the SeTAC TK device and disable the outputs (OUT1-OUT3). To modify 
system settings, click as follows: 

File ► Administrator Log On (enter the password) 

 
Tools ► System settings 
 
The Administrator can then synchronise the clock of the device with that of the 
computer or set this manually. 

Fig. 23: Level threshold – background colour 
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The output can be disabled and alarm duration can be set in the Configuration 
I/O frame. In this way, alarm signals will not be furnished and events will not be 

generated in the event log. This method should be used only in the setup 
phases and, when active, a red flashing warning will be shown on the status 
bar. 

 

Event log  

Each time a limit is exceeded, the software generates an event and the system 
records this in a dedicated memory (event log) inside the SeTAC TK sensor. For 
display via Machine Airbag of events present in the event log, press the F2 key 

or locate the menu bar and click as follows: 

 

Tools ► Event log ► On device  

 

In addition to displaying events, it is also possible to load events from a file, 
clicking as follows: 

Tools ► Event log ► Load from file 

Events can also be exported to a text file with the command: 

Tools ► Event log ► Save to file. 

 

Fig. 24: System setting 
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The structure of the event log comprises two tables (Fig. 25). Each table shows 
the number of the event (ID), the date with indication of the time, and the 
description of the event. 

The table to the right shows events relating to Limit3 and filters and is dedicated 
to detecting collisions in the work area. 

The table to the left shows the descriptions of events relating to Limit1 and 
Limit2 also settable by the SuperUser. 

All modifications to monitoring parameters are also recorded in the event log 
with indication of the time and modification made. 

Fig. 25: Event log – events logged 
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Graphics Area  

Machine Airbag shows the vibration acceleration measurements detected close 

to the spindle in a graphic window called the Graphics area (Fig. 26). This 
window behaves similarly to the screen of an oscilloscope and displays the 
trend of vibrations measured close to the spindle. 

The following are shown in the lower part of the Graphics area: 

• the key to access the graphics control panel to set the various graphic 
options (key identified by the red arrow in Fig. 26);  

• a combobox with the labels and colours of the curves; 

• the parameters of the axes of the graph. 

Fig. 26: Graphics area with control panel 
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Control panel 

From the control panel, it is possible to modify the scale, offset and colour of 
each measurement made. The Stop checkbox (Fig. 26) interrupts acquisition of 
the data and permits numeric analysis of the signals. For fast analysis of a 
quantity: 

• Select the quantity to be analysed in the tab panel; 

• Tick the Stop checkbox ; 

• Double click the graphics area to display two vertical delimiting lines 
(white in Fig. 26). 

Various characteristic values of the signal can now be read directly in the 
delimited zone, such as: 

• time  

• number of samples; 

• mean value; 

• maximum Peak-Peak value (pk-pk); 

• RMS; 

• maximum and minimum measured in the range; 

• samples measured. 

It is possible to export the measurements highlighted to a text file and/or to 
zoom on the zone. 

 

Status bar  

The status bar (Fig. 27) is displayed in the lower part of the Machine Airbag 

window and shows the following information: 

• firmware loaded (Ver. xxx); 

• serial number of the SeTAC TK sensor (SQ-S-xxxxxx); 

• software version; 

• indication of Administrator mode “A” or SuperUser mode “S” (highlighted 

Fig. 27: Status bar. 
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in red); 

• the last cells (green) show the status of the output which is On when the 
number of the output activated is displayed as in figure.  
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Application notes 

 

 

 
  

Modern CNCs are designed for increasingly efficient machine tool operation in 

order to optimise machining processes and increase productivity. To guarantee 

such a high level of efficiency, machine stoppages and process rejects must be 

reduced to a minimum. It is essential, therefore, to avoid irregularities such as 

collisions in the work area of the machine tool or vibration overloads and also to 

minimise maintenance costs due to repair or replacement of parts. 

SEQUOIA IT, a leading company with long-term sector-specific experience in 

the development of expert solutions for vibration monitoring, has developed 

SeTAC for Machine Tools to cater to these requirements of machine tool 

manufacturers and users. 

SeTAC for Machine Tools is a vibration monitoring system able to: 

• detect collisions in the work area;  

• detect vibration overload; 

• calculate spindle effective hours of operation; 

• act as machine tool black box. 

Machine Airbag is the software developed by Sequoia IT for management, 
control and programming of SeTAC Machine Airbag system functions. 

In-depth knowledge of the philosophy of use of the system will allow the user to 
adopt the system with maximum productivity. 

Users are invited to read the text below carefully. This describes the 
recommended techniques for monitoring of collisions, overload and calculation 
of spindle life and also the philosophy of use of the entire SeTAC for Machine 
Airbag system. 
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Collision detection 

The system of protection against collisions implemented by SeTAC for Machine 
Tools is based on observation of the fact that: 

• collisions are events of short duration that generate vibrations of high 
level intensity; 

• the frequency of vibrations caused by a collision is within a clearly 
defined range. 

 

SeTAC for Machine Tools detects collisions on the basis of the above 

considerations. 

SeTAC for Machine Tools detects impacts in the work area of the machine tool 
through synergic use of a pass band filter that makes it possible to detect the 
presence of collision-induced vibrations, combined with a set of level thresholds 
(to be set on Limit 3) that continually compares the acceleration module 
detected with a threshold value. 

When accelerations within the range concerned and with module exceeding the 
threshold are detected on the machine tool, the software detects the collision. 
The Administrator must, therefore, set the cut-off frequencies of the low pass 
and high pass filters and apply a level threshold on the value of the acceleration 
module on Limit3. 

For the installer and/or user, the first problem is to identify the cut-off frequency 
of the pass band filter. 

The best way to identify low pass and high pass filter cut-off frequencies is to 
move the machine axes in fast feed mode and to increase the frequency of the 
high pass filter until vibrations are no longer detected by the Machine Airbag. 

In this way, the characteristic frequencies of the foundation-machine tool system 
are suppressed and, in the case of impulse events, the system will be able to 
discriminate the collision. The dedicated algorithm specifically developed by 
SEQUOIA IT also prevents detection of false collisions and, therefore, 
undesired machine blockages. 

Some of the values to be used during Machine Airbag configuration are 
indicated on page 21. However, for selection of the value of the cut-off 
frequencies to be set in the band filter and in the threshold values of the 
acceleration module, Sequoia IT provides customers a dedicated assistance 
service for customisation of SeTAC for Machine Tools according to their 
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machine tools. 

If the system is equipped with a SeTAC TK Interface that manages the output 

using fast relays, in the case of collision, SeTAC TK will stop the machine tool in 
just 1 ms, thus reducing possible damage to a minimum. Fast stopping is 
afforded by the advanced architecture of SeTAC for Machine Tools and the use 

of forefront technologies such as MEMS sensors and fast processors. 

Collisions detected are recorded in the event log (black box function) and, as 
indicated previously, the machine tool stopping system is activated.  

During the warranty period, this capability provides machine tool manufacturers 
with documented feedback regarding correct operation by the machine tool 
user, avoiding or reducing claims due to improper use to a minimum. 

 

Vibration overload 

During machining, vibrations may increase due to various reasons (use of 
incorrect technological parameters, presence of phenomena such as chatter , 
spindle imbalance, worn tools or other factors) with negative repercussions on 
surface finish and workpiece quality. 

A high level of vibrations may also cause fatigue failure of machine tool 
components. SeTAC for Machine Tools overcomes these problems by 

constantly monitoring vibrations during the work cycle and, through application 
of limit level thresholds set by the Administrator or SuperUser (Limit1 and 
Limit2), is able to detect these situations and provide fast alarm response. 

If the system is equipped with a SeTAC TK Interface that manages fast relays, 
SeTAC TK will stop the machine tool in just 1 ms, thus reducing possible 

overload damage to a minimum.  

The most suitable physical parameter for checking vibration overload is RMS 
velocity, setting limit thresholds on the RMS velocity value. The main problem 
facing the installer and/or user is to identify the RMS velocity value. Sequoia IT 
recommends use of an RMS threshold value equal to at least twice the 
maximum RMS value recorded during a normal work cycle, and use of Limit1 
and Limit2 for overload monitoring. 

In the case of vibration overloads, if the SeTAC TK Interfaces that permit 

integration of vibration data in field buses are used, it is possible to select limit 
thresholds L1 and L2 that change dynamically according to the process or tool 
used in order to trigger not only general machine alarms but alarms relating to 
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the single process phases. These alarms can be used to modify cut-off 
parameters and/or to stop the machine. 

Sequoia IT offers customers a dedicated assistance service for customisation of 
SeTAC for Machine Tools according to their machine tools. 

As mentioned, SeTAC for Machine Tools is also a machine tool black box; the 

system records overload phenomena in the event log (table to the left), 
providing the manufacturer with documented information on correct use of the 
machine by the user and avoiding claims due to improper use in the warranty 
period. 

 

 

Calculation of spindle service life consumed 

During mechanical machining, the spindle of a machine tool is subject to 
variable loads. The dynamic load transmitted depends on the type of process 
and process technological parameters.  

These loads may be dynamic, periodic or pseudoperiodic and cause stress on 
various components of the spindle such as fatigue, wear, impacts and also 
mechanical stress. 

It is well known that spindle components most affected by this stress are the 
roller bearings that, in most cases, characterise the entire life of the spindle.  

To understand how it is possible to forecast spindle service life using SeTAC for 
Machine Tools, it is necessary to recall the formula for calculation of the basic 
rated life of a bearing and then determine various considerations using this 
formula. 

The standard method for calculation of dynamically stressed bearings is 
specified in ISO 281:2007 (E) according to which the basic rating life of 
bearings (usually calculated in millions of revolutions with a reliability factor of 
90% on a set of identical bearings operating in identical conditions) can be 
determined according to the following formula: 

k

Rated

P

C
=L 









0
10  

where: 

• C is the basic dynamic load rating of the bearing; 
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• P0 is the equivalent dynamic bearing load; 

• k is a coefficient equal to 3 for ball bearings and 10/3 for roller bearings. 

Designers adopt a value of P0 (determined considering the harshest or design 
operating mode) and select bearings with a value of C such as to meet service 
life requirements.  

Consequently, spindle roller bearings are usually selected in order to guarantee 
a service life of 20,000 to 30,000 hours. 

If operating conditions differ considerably from those used for calculation, 
effective service life of the spindle is modified and may differ considerably from 
theoretical service life.  

Obviously, if a machine is exposed to a level of stress much higher than design 
values, the spindle will have a much shorter life span than in the case of a less 
severe process. These situations occur frequently and can be ascribed to 
various factors such as incorrect selection of machining parameters (in 
particular roughing operations) or a not perfectly balanced spindle or other 
factors.  

If spindle load is not “constant” or precisely determined and the spindle is 
required to operate in a highly variable load cycle, how can consumption of 
spindle service life be determined? 

To answer this question, after years of research into vibrations and extensive 
experimentation campaigns, Sequoia IT has developed a method for calculation 
of spindle service life consumption. The main guidelines of this method are 
explained below. For further information, reference should be made to the 
indications of specific literature on this method.  

As mentioned, bearings are components that affect the entire service life of the 
spindle and also a source of information regarding spindle health. 

During a generic process, direct measurement of the dynamic load P acting on 
a bearing is a difficult task. However, experience has confirmed that this is 
closely related to the level of vibrations. 

As, during a process, the dynamic load P acting on a bearing differs from the 
design value Po, we can write: 

P = h P0  (1) 

where h is a coefficient that is a positive value usually greater than 1. 

Experimentation campaigns and dimensional analyses of results have shown 
that, with a good level of approximation, the value of h depends on RMS 
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vibration velocity. 

It can be readily seen that, as RMS vibration velocity increases, the coefficient h 

also increases with a consequent reduction in bearing service life. In other 
words, stress increases as RMS vibration velocity increases with a reduction in 
the service life of the bearings. 

 

VIBRATION RANGE  EFFECT EQUIVALENT HOURS  
fdr 

0 – 2       mm/s Irrelevant 1 

2 – 2,5    mm/s Slight 1,1 

2,5 – 3    mm/s Low 1,2 

3 - 3,5     mm/s Medium 1,5 

3,5 – 4    mm/s  Medium High 2 

4 – 5       mm/s High 4 

5 – 8       mm/s   Damaging 10 

8 – 12,75 mm/s Extremely damaging 20 

According to the RMS value measured on the nose of the spindle, vibration 
severity can be determined by dividing the measurement range of the RMS 
vibration velocity into various intervals covering a range from 0 to 12.75 mm/s. 

According to these hypotheses, bearing service life assessed according to the 
RMS value falling within the i-th range of vibration will be: 

fdr

L
=

h

L
=

hP

C
=

hP

C
=

P

C
=L

Rated

k

Rated

k

k

o

k

o

k
i 1010
10

1























     (2) 

where: 

fdr=hk   (3) 

is the reduction factor of spindle service life, i.e. how many theoretical hours of 

operation correspond to an effective hour of operation at a vibration velocity 
falling in the i-th interval (e.g. 1 h of operation with an RMS vibration velocity of 
around 9m/s is equivalent to 20 hours of operation in design conditions). The fdr 

values for intervals of RMS vibration velocity are shown in table ---. 

For completeness, Li
Total is defined as number of revolutions before failure of the 

spindle for an assigned value of P and Li
Service as the number of revolutions of 

the spindle for operation in the same load conditions.  

Failure occurs when: 
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 Li
Service = Li

Total =L(i)
10 (in million revolutions)   (4) 

Generally, the fraction of life consumed at a generic time t is calculated 

according to the relationship: 

( )
( )

( )i
rated

i
service

L

L
=tDamage     (5) 

and the bearing no longer performs its task when damage is unitary. 

Spindle accumulated damage can be assessed according to Palmgren and 
Miner’s rule on the basis of the relationship: 

( )

( )

( )

( )

( )

( )∞−

∞−

−

−

−

−

12.75

12.75

2.52

2.52

20

20

..
Total

Service

Total

Service

Total

Service

L

L
++

L

L
+

L

L
=Damage(t)   (6) 

replacing relationship (2) in (6) for each i-th vibration range: 

( )

( )

( )

( )

( )

( )12,75Rated
Total

Service
2.52Rated

Total

Service
20Rated

Total

Service fdr
L

L
++fdr

L

L
+fdr

L

L
=Damage ⋅⋅⋅ −

−

−

− 12.752.5220

..  

To determine the actual fraction of spindle life consumed, we can write: 

( ) ( )
( )

( )
( )

( )
( )12.758

12,758
Service2,52

2,52
Service20

20
Service

Rated
Totaleffective fdrL++fdrL+fdrL=LtDamage=L −

−
−

−
−

− ⋅⋅⋅⋅ ..  

where Leffective is the effective life consumed in revolutions due to effective 
functioning. If, instead of spindle revolutions, reference is made to hours of 
operation, the equation for calculation of effective hours of operation consumed 
can be rewritten in the form: 

( ) ( )
( )

( )
( )12.758

12,758
Service20

20
Service

Rated
Totaleffective fdrHours+.+fdrHours=HourstDamage=Hours −

−
−

− ⋅⋅⋅ .

 

It can be noted that this relatively simple calculation requires estimation of fdr 

values, possible only after years of work in the sector and with documented 
experience. 
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